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Preliminary notes

229.01.2020

Hardware: OPUS A3/A6/A8 Hardware Manual 

Software: Operating System (OS): OPUS C / C++ Developer Guide

Projektor-Tool: HTML Help 

CODESYS: Codesys Operator Manual 

OPUS Devices Update Manual

Operators must read these installation instructions, particularly the safety information, and must be familiar with the 

operation of the equipment. 

The following topics among others can be found in the above hardware and software documents : Used Instructions 

Types, Safety instructions, guarantee and liability, Intended Use, Getting Started and Technical Documentation 



Legal notes

329.01.2020

All operating manuals and products names cited in the operating Trademarks manual are registered trademarks of  Topcon 

Electronics GmbH & Co KG All rights reserved, including translation.

No part of this operating manual may be reproduced, in any form, (print, photocopy, microfilm, or a different process), nor 

may it be processed, duplicated, or distributed using electronic systems, without written permission from Topcon 

Electronics GmbH & Co KG, Geisenheim.

All previous versions are rendered obsolete with publication of new manuals. All information contained herein is subject to 

correction, manufacturer is not liable for any errors in this presentation 



Agenda

429.01.2020

1. Introduction

2. Installation of the Projektor Tool

3. Getting to know the Projektor Tool

4. Updating your device

5. First project

6. CAN communication

7. Extended agenda

8. FAQ



1. Introduction – About me

529.01.2020

• Dipl.-Ing. Electrical Engineer

- Over 9 years experience for Wachendorff Elektronik / Topcon Electronics

- Main work areas:

- Customer support via phone / email

- Trainings and workshops

- Creation and maintenance of trade show / example projects and technical documentation



1. Introduction – Training targets

629.01.2020

Training targets:

• Understanding the project design concept of the Projektor Tool

• Learning the basic objects and their usage

• Being able to configure the CAN protocol you need

• Understanding what JavaScript is needed for



1. Introduction – Projektor vs. PClient

729.01.2020

The Toolchain consists of:

Projektor Tool on your PC

PClient* and Linux OS on your device

*Projektor Client

• Used to create projects

• One tool for A3, A6 G1, A6 G2 & A8

Linux OS

PClient

Your project



Agenda

829.01.2020
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2. Installation of the Projektor Tool

929.01.2020

The installation file for the Projektor Tool 

can be found under \Projektor

Please install the Projektor Tool by double-

clicking the installation file



2. Installation of the Projektor Tool

1029.01.2020

Click through the steps in the installation:

- Accept the license agreement

- Choose an installation folder (1)

(depending on the user rights, you can’t install to 

program files (3), choose a folder where you 

have full rights)

- Choose the latest Java 8 version (64 bit!)

- Click Next to continue, then Install to start the 

installation

start the Projektor Tool after the 

installation (first start may take longer)

Copy the training material folder from the USB 

stick to your hard drive



Agenda

1129.01.2020

1. Introduction

2. Installation of the Projektor Tool

3. Getting to know the Projektor Tool

4. Updating your device

5. First project

6. CAN communication

7. Extended agenda

8. FAQ



3. Getting to know the Projektor Tool – Program overview I

1 – Project Tree

2 – Main Window

3 – Object Palette

4 – Object Properties

5 – Variable View

http://upload.wikimedia.org/wikipedia/commons/5/59/Info_blue.svg


3. Getting to know the Projektor Tool – Program overview I

1329.01.2020

Project name

Homepage

Object IDs

Menu bar
Tool bar

Object properties

and events

Palette objects

Image Library tab

Symbol Library tab

http://upload.wikimedia.org/wikipedia/commons/5/59/Info_blue.svg


3. Getting to know the Projektor Tool – Program overview II

1429.01.2020

Find variable

usages

New variable

Search box

Variables

New project

Open project

Save project

Project download

PClient SimulationCAN mappings

OS/PClient download

Variable manager
Current Theme

http://upload.wikimedia.org/wikipedia/commons/5/59/Info_blue.svg


1529.01.2020

If you don’t like the dark look, go to 

Tools -> Options

and in the dialog to the tab Appearance

Choose a skin that you like

3. Getting to know the Projektor Tool – Changing the skin



Agenda

1629.01.2020

1. Introduction

2. Installation of the Projektor Tool

3. Getting to know the Projektor Tool

4. Updating your device

5. First project

6. CAN communication

7. Extended agenda

8. FAQ



4. Updating your device

1729.01.2020

All elements of the Toolchain should be on the same level, as they are tested and released by us:

Projektor Tool on your PC

OS on the device

PClient on the device

-> When you purchase new devices, always perform a software update first!



4. Updating your device – Creating the USB stick

1829.01.2020

In the Projektor Tool, click the 

PClient / OS Update Button or go to the 

menu Update -> PClient / OS Update

Insert a USB stick into your PC

-> FAT 32 formatted!

In the dialog, choose the device you are 

working with

Leave PClient and Operating System 

checked 

Select the correct drive and click 

Create USB Update Drive

Let’s take a look at the created files



Service image

4. Updating your device – The update files

1929.01.2020

The update packet for your device consists of:

A3 / A6 G1 A6 G2 / A8

OS – Operating System. A customized embedded Linux system.

Service files to update from OS 1

PClient – Projektor Client. The application that displays your project on the device.

Boot logo – The image that is displayed when the device is started -> created by the customer (see chapter 8)

Boot loader

Root file system

Power management

firmware
Linux kernel



4. Updating your device – The developer cable

2029.01.2020

What are all those clamps on the developer cable?! cable color 

A/DI 1 – 4 – Analog / Digital Inputs brown,green,yellow,grey

DO 1 – 3 – Digital Outputs white,lilac,blue

RS232 – serial console of the Linux system RxD-red-blue,TxD-red,GND-pink

CAN1/2 – CAN ports CAN1-pink(high),blue(low)

CAN2-green(high),yellow(low)

USB – USB VCC-red,GND-black,Low-white,High-green

Clamp 30 – Battery plus red

Clamp 15 – Ignition (Should be connected into Clamp 30) red-blue

GND / Car GND – Ground (Should be connected if separate clamps) GND-black,CarGND-white, black connector(s)

Serv_EN – Service Enable black



4. Updating your device – Preparations

2129.01.2020

1. Power off the device

2. Connect the USB stick containing all 

update files with the device

3. Power up the device in service mode by

a) Connecting clamp service enable

or

b) Pressing the left keys 1 + 2 during   

power up (hold for 3 seconds)

(for all devices but the A8)

Key 1 + Stop key (A8)

3 a)

3 b)



4. Updating your device – Almost done

2229.01.2020

When you see this screen (or similar), 

let go of the keys or disconnect the clamp 

service enable

The update takes 3-5 minutes after which 

the device will restart and, after the touch 

screen calibration, show the welcome 

project.

Please never disconnect the power from 

the device during the update process!

Always wait until the device has restarted!



Agenda

2329.01.2020

1. Introduction

2. Installation of the Projektor Tool

3. Getting to know the Projektor Tool

4. Updating your device

5. First project

6. CAN communication

7. Extended agenda

8. FAQ



5. The first project

2429.01.2020

1. Create a new project

2. The first page

3. Meter object

4. Download the project

5. Linear Bar graph

6. Numeric field

7. The second page – Navigation 

8. Buttons

9. List objects

10. 2D graph



5.1 The first project – Create a new project

2529.01.2020

To create a new project, 

click the        button in the toolbar or 

use the menu File -> New Project…

In the first step of the dialog, you can choose 

between an empty project or some sample 

projects

Choose Empty Project and click Next*

*be sure to check out the sample projects when 

you’re back home



5.1 The first project – Create a new project

2629.01.2020

Choose a project name and location and

choose your device

Click finish to create the project.

All other settings can be changed later.



5.2 The first project – Project structure

2729.01.2020

In the Project Tree on the left, open the project 

by double-clicking the project name

Then open the Pages by double-clicking the  

Pages (1) entry

Now double click the 

Home Page to view it in the editor window

Click on the gray frame in the virtual device

1. 2.

3.



5.2 The first project – The first page

2829.01.2020

We now have:

a project

with one page which is called Home Page

In the Home Page there is a Frame

The frame is the primal object on every page –

all other objects can only be inside of frames!

The project also has

Alarms category

Communication (for CAN Mappings)

Virtual Keyboards category

JavaScripts category

http://upload.wikimedia.org/wikipedia/commons/5/59/Info_blue.svg


5.2 The first project – The first page – Frame object

2929.01.2020

Click in the center of the gray area to select the 

frame

Now the properties of the frame are shown

Un-Check the property Draw Border

Open the Image Library tab

Load the Training pictures folder 

(inside the training material folder you copied 

from the USB stick)



5.2 The first project – The first page – Frame object

3029.01.2020

Drag & Drop the marked image on the frame 

(the gray area)

In the context menu, select the Frame and then 

Background Image



5.2 The first project – The first page – Frame object

3129.01.2020

The result should look like this.

The modified properties will be marked blue.

If you select a modified property, the last saved 

(or default) value will be shown in the 

description area



5.2 The first project – The first page – Information about images

3229.01.2020

Most image formats are supported: JPG, BMP, GIF, TIFF, PNG, SVG

Internally all bitmap images are converted to PNG in the Projektor, so use PNG if you create graphics

Animated GIF files are also possible -> See example project

http://upload.wikimedia.org/wikipedia/commons/5/59/Info_blue.svg


5.3 The first project – Meter object

3329.01.2020

Goals:

Create a meter object and configure it

Reference a variable to the meter

Make the meter editable



5.3 The first project – Meter object – Creation and variable reference

3429.01.2020

Meter objects are the classic instrument to

visualize values graphically

Useful for speed, RPM, fuel levels

Can be used full circle or just a part

Drag & drop a meter object into 

the frame

Resize it so it fits into the inner white circle

Search for the variable

@DispBacklightIntensity and drag & drop 

it on the meter. In the context menu,

choose the Meter object and then 

Variable Reference



5.3 The first project – Meter object – Properties

3529.01.2020

Make the marked settings in the 

properties of the meter object.

Result:

Start here

A warning dialog will appear for this property.

Press OK, it will be explained later.

Continue

here



5.3 The first project – Meter object – Start and end angle

3629.01.2020

The spanning direction for the

meter area is always counterclockwise

This has nothing to do with which way the

needle will move!

0°/ 360°

90°

180°

270°

215°
End

325°
Start

http://upload.wikimedia.org/wikipedia/commons/5/59/Info_blue.svg


5.3 The first project – Meter object – Needle image

3729.01.2020

Possible to use images as needles instead

of the standard needle

Image has to be squared

Needle has to point to the right

Center of the image is the turning point

http://upload.wikimedia.org/wikipedia/commons/5/59/Info_blue.svg


5.3 The first project – Meter object – Minimum and maximum

3829.01.2020

Absolute 

maximum

Three value regions

Configurable color changes

Absolute limitations are for user entries

Value changes over CAN can exceed 

the limits

Value

Absolute 

minimum
Minimum Maximum

Normal rangeLow range High range

http://upload.wikimedia.org/wikipedia/commons/5/59/Info_blue.svg


5. The first project

3929.01.2020

1. Create a new project

2. The first page

3. Meter object

4. Download the project

5. Linear Bar graph

6. Numeric field

7. The second page – Navigation 

8. Buttons

9. List objects

10. 2D graph



5.4 The first project – Download the project - @EnableUpdater

4029.01.2020

The variable @EnableUpdater controls if 

the update over USB, CAN and Ethernet are 

allowed

Bit 0: USB

Bit 1: CAN

Bit 2: Ethernet/LAN

@EnableUpdater

value

Update over

USB

Update over

CAN

Update over

Ethernet

0   

1 (default)   

2   

3   

4   

5   

6   

7   



5.4 The first project – Download the project - @EnableUpdater

4129.01.2020

We will create a script that is executed 

when the device starts

Right-click on JavaScripts and click 

New File…

Choose JavaScript Samples and select

OnProjektInit_Template

Click Finish to create the script file



5.4 The first project – Download the project - @EnableUpdater

4229.01.2020

Click on the project name in the project 

tree and click the     button next to 

OnProjectInit in the Events tab



5.4 The first project – Download the project - @EnableUpdater

4329.01.2020

In the dialog, uncheck No Action and choose the 

script file

Click OK to close the dialog



5.4 The first project – Download the project – Save!

4429.01.2020

Before downloading a project, ALWAYS save 

it, otherwise you will only get the last saved 

state of the project

If elements of your project are colored blue or 

green, they are modified or new, so you need

to save before downloading.



5.4 The first project – Download the project - USB

4529.01.2020

To download the project, 

connect a USB stick (FAT 32 formatted) 

with your PC

Press the Project Update button         

or go to the menu Update -> Project Update 

Select USB in the dialog

Select the drive of the stick to download 

the project.

Click Transfer to install the project

When the download has finished, 

put the USB stick into the 

operating device and the project 

will be loaded automatically.



5.4 The first project – The first page – Download the project - CAN

4629.01.2020

To download the project via CAN, some 

settings have to be made:

1. Setting the variable @EnableUpdater

2. The CAN port that should be used

3. The baud rate 

For your first transfer, you can make these 

settings in the welcome project on the 

device

But the settings still need to be made in 

the Projektor, or the settings made above will be 

reverted after the project download!

1.

2.

3.



5.4 The first project – The first page – Download the project - CAN

4729.01.2020

Press the Project Update button          

Select CAN in the dialog

Agree to the warning

The PC settings normally don’t have to be 

changed



5.4 The first project – The first page – Download the project - CAN

4829.01.2020

In the Device CAN Settings, check 

Edit Device Settings and set the CAN Port 

that should be used for the next update

(should be the same as the setting in the 

welcome project

The baud rate is set according to the 

project setting in

Communication -> Port Configuration…

Click Transfer to install the project



5.4 The first project – The first page – Download the project - Ethernet

4929.01.2020

To download the project via Ethernet, some 

settings have to be made:

1. Setting the variable @EnableUpdater

2. The IP address that should be used

3. The netmask address that should be 

used

For your first transfer, you can make these 

settings in the welcome project on the 

device

But the settings still need to be made on 

the PC, or the settings made above will be 

reverted!

1.

2.

3.



5.4 The first project – The first page – Download the project - Ethernet

5029.01.2020

Press the Project Update button          

Select Ethernet in the dialog

Use Scan Network… to look for the 

connected device

In the Device Ethernet Settings tab, set the 

IP address that the device should have.

Click Transfer to install the project



5. The first project

5129.01.2020

1. Create a new project

2. The first page

3. Meter object

4. Download the project

5. Linear Bar graph

6. Numeric field

7. The second page – Navigation 

8. Buttons

9. List objects

10. 2D graph



5.5 The first project – Linear Bar graph

5229.01.2020

Goals:

Create a linear bar graph object

Reference a variable to it



5329.01.2020

Drag & Drop a Linear Bargraph object into 

the frame

Modify size and position as seen in the 

picture

Reference the Bargraph with the variable 

@DispBacklightIntensity

Save and download the project to 

the device and test it

5.5 The first project – Linear Bar graph



5.6 The first project – Numeric field

5429.01.2020

Goals:

Create a new font attribute

Create a clock with 3 numeric fields



5.6 The first project – Numeric field – A new font attribute

5529.01.2020

Formatting texts is done with 

font attributes

A font attribute consists of

- size

- color

- style (bold and / or italic)

Advantage: changes throughout the project

with one click

Font files can be imported

(think about copyrights)

http://upload.wikimedia.org/wikipedia/commons/5/59/Info_blue.svg


Open the project properties

by right-clicking the project name and 

selecting “Properties”

or by using the menu 

File -> Project Properties

Choose the category “Font Attributes”

Enter a name for a new font attribute (1)

and click “Add” (2)

Change 

Size to 16

Style to Bold

Font Color to a dark red (3)

5.6 The first project – Numeric field – A new font attribute

5629.01.2020

1

2

3



5.6 The first project – Numeric field – Creation and variable reference

5729.01.2020

Drag & drop a Numeric field in the page

Search for RTC variables 

Reference the variable @RTC_Seconds



5.6 The first project – Numeric field – Properties

5829.01.2020

Make the marked settings in the 

properties of the numeric field.

Adjust the size so that only one zero is 

displayed before the 1.

Result:



5.6 The first project – Numeric field – Complete the clock

5929.01.2020

Use copy & paste to duplicate the 

configured numeric field

-> After copy, select the frame and then 

paste

Use the variables @RTC_Minutes and 

@RTC_Hours and reference them to the 

numeric fields

Save and download the project to 

the device and test it

You can move objects with the cursor keys (1 pixel)

- with ALT pressed: 5 pixels

- with CTRL pressed: 10 pixels 

- with SHIFT + ALT pressed: 50 pixels

- with SHIFT + CTRL pressed: 100 pixels 

Use the alignment buttons to align selected objects

http://upload.wikimedia.org/wikipedia/commons/5/59/Info_blue.svg


5.6 The first project – Numeric field – Complete the clock

6029.01.2020

Hint: 

Change the name of the objects in the 

properties to something meaningful

Helpful for larger projects, for colleagues to 

understand and for our technical support



5.6 The first project – Numeric field – Complete the clock

6129.01.2020

Try using two string fields to create the 

colons

-> The content of the string fields can be 

changed with a double click or by changing 

the property Preview Value of the String Fields



5.6 The first project – Numeric field – Let’s set the clock

6229.01.2020

Sometimes the clock will be set wrong, so 

we want to be able to set it

Select the numeric fields and activate the 

property Set As Input

-> Remember the property

Connect To Encoder from the meter object?

Deactivate it to be able to access the 

numeric fields

-> Did you have trouble clicking on the 

numeric fields because of the string fields?



5.6 The first project – Numeric field – Z-Order

6329.01.2020

Objects have an order reflected by the 

position in the project tree

This also determines which object is 

selected at startup and in which order they 

are selected by the encoder

http://upload.wikimedia.org/wikipedia/commons/5/59/Info_blue.svg


5.6 The first project – Numeric field – Z-Order – Roll over

6429.01.2020

There’s a property Roll over

for frames which will remove the “end” when 

navigating with the Encoder

The property can only be set with JavaScript

(setProperty function)

http://upload.wikimedia.org/wikipedia/commons/5/59/Info_blue.svg


5.6 The first project – Numeric field – Z-Order

6529.01.2020

Change the Z-Order by using the buttons in 

the editor toolbar

or by right clicking the object and choosing 

ZOrder in the context menu

OR with Drag&Drop directly in the project tree!

Move forward

Move back

http://upload.wikimedia.org/wikipedia/commons/5/59/Info_blue.svg


5.6 The first project – Numeric field – Let’s set the clock

6629.01.2020

-> Bring the colon string fields to the back 

so they don’t disturb you

Save and download the project to 

the device and test it



5.6 The first project – Numeric field – borders

6729.01.2020

Borders are used to show which object is 

currently selected / edited by the encoder

Not selected -> disabled for modern 

themes

Selected

Edited

http://upload.wikimedia.org/wikipedia/commons/5/59/Info_blue.svg


5.7 The first project – The second page (Navigation)

6929.01.2020

Goals:

Create a second page

Configure soft keys with images

Configure the navigation between pages



5.7 The first project – The second page (Navigation)

7029.01.2020

Create a new page by right clicking Pages 

and selecting New Page

Go back to the Home Page



5.7 The first project – The second page (Navigation) – The keys

7129.01.2020

To use the soft keys, right click on the right 

soft key frame and select 

Create Softkey Level

Now you can access the single keys

Drag & drop the gray arrow right from the 

Image Library onto the softkey

In the context menu, select SoftKey1 and then

Released Image



5.7 The first project – The second page (Navigation) – The keys

7229.01.2020

Open the Image Library again and drag & drop

The orange arrow right on the SoftKey1

and select Pressed Image in the context menu

You can check the results by switching the 

property Pressed State*

Disable the property when you’re done

Result:



5.7 The first project – The second page (Navigation) – There…

7329.01.2020

Select the soft key, go to the tab Events 

and select the      button of the event OnRelease

Uncheck No Action, choose the action

Jump To Page and select Page 1



5.7 The first project – The second page (Navigation) – …and back again

7429.01.2020

Open the Page 1 and do the following:

- Disable Draw Border

- Load the image file

Training_Background_2.png

from the Image Library as the 

background image of the frame

- Create a soft key level in the right

soft key frame



5.7 The first project – The second page (Navigation) – And back again

7529.01.2020

This time drag a string field into the first 

soft key, make it transparent, use the font 

attribute Text White, change the font to 

DejaVu Sans and the Preview Value to 

Home

Enable the Pressed State and repeat the 

same, only use the font attribute 

Text Bold White

Use the event On Release, choose the 

action Jump To Page and select the home 

page

Save the project



5.7 The first project – The second page (Navigation) – The simulation

7629.01.2020

To test the navigation, enable the PClient 

simulation in the toolbar and press the 

button (Re)Start

In the simulation you can test your project 

easily

Use the mouse wheel for encoder 

movement

Everything works except hardware specific

variables



5.8 The first project – Buttons

7729.01.2020

Goals:

Create some buttons

Configure their functionality

Learn about latching



5.8 The first project – Buttons – Push button

7829.01.2020

In the variable view, hide the pre-defined 

variables and create two variables

Rename the variables by double clicking

the name, change them to push_button

and switch

Create a button object and a numeric field

Reference both objects with the variable

push_button

Save and download the project to 

the device and test it



5.8 The first project – Buttons – Switch button

7929.01.2020

Create another button and numeric field 

and reference the variable switch

In the properties for the button, activate 

the property Latching

Save and download the project to 

the device and test it



5.8 The first project – Buttons – Switch button

8029.01.2020

Create another button and numeric field 

and reference the variable switch

In the properties for the button, activate 

the property Latching

Save and download the project to 

the device and test it

-> Observe the different behavior

-> Besides connecting buttons with a 

variable, the events can be configured as 

well

push_button

switch



5.8 The first project – Buttons – New objects – Lamps and Switches

8129.01.2020

New in OPUS Projektor 2018

Lamp

Push Switch

Rocker Switch

Power Switch

The objects behave like buttons, with 

pre-configured images



5.8 The first project – Buttons – New objects – Gauge

8229.01.2020

New from OPUS Projektor 2018

Gauge

Gauge 270

Gauge 180

Gauge 90

Alternative for the meter object with ticks, tick 

values, digital value and colored value regions

Tons of properties to modify almost all details of 

the object



5.9 The first project – List objects

8329.01.2020

Goals:

Learn what list objects are used for

Load them with objects

Configure which object is seen



5.9 The first project – List objects – Use case 1: Icon folder

8429.01.2020

Select the three traffic light images in the

Image Library by pressing CTRL and clicking to 

select

The number shows the order in which they will 

Be used

Drag & drop the images on the frame and select

Add Images Into New List in the context menu



5.9 The first project – List objects – Use case 1: Icon folder

8529.01.2020

Create a new variable traffic_light

Reference the list object to the new 

variable traffic_light

Create a Numeric Field next to the list

Connect the variable to the Numeric Field 

and make it editable

Save, download & test



5.9 The first project – List objects – Use case 2: Drop down menu

8629.01.2020

List objects can also be used as 

drop down menus

Create a List object, open the List Items dialog

Select String Field in the dropdown menu and 

press Add 10 times to add 10 String Fields

Set the list as input

Set Number of visible items in editing mode

to 5



5.10 The first project – 2D graph

8729.01.2020

Goals:

Learn how to configure 2D Graphs

Create input objects for Zoom, Navigation 

and Cursor



5.10 The first project – 2D graph

8829.01.2020

Create 3 new variables, named

- Zoom (X axis time variable)

- Move (X axis offset variable)

- Cursor (Cursor Position Variable)

Drag & drop a Graph object into the frame

Reference @RTCSeconds as Variable to 

Draw and the 3 new variables for time, 

offset and cursor

Create 3 editable Numeric Fields and 

reference them to the 3 variables

Save, download & testAvailable as example project

http://upload.wikimedia.org/wikipedia/commons/5/59/Info_blue.svg


5. The first project – Recap

8929.01.2020

We have learned how to

- update our device software

- create and download projects for our device

- use and configure the objects 

Meter Picture Graphic

Bar Graph Button

Numeric Field List Object 

String Field 2D Graph

- create and use variables and connect them with objects

- use font attributes

- configure editable objects

- integrate images for backgrounds, buttons etc.



5. The first project – Recap

9029.01.2020

We have learned how to

- update our device software

- create and download projects for our device

- use and configure the objects 

Meter Picture Graphic

Bar Graph Button

Numeric Field List Object 

String Field 2D Graph

- create and use variables and connect them with objects

- use font attributes

- configure editable objects

- integrate images for backgrounds, buttons etc.

What did we omit?

- Arched Bargraphs (work just like linear, can be stretched to 

any angle

- Symbol Library (comes in Demo mode, over 2400 symbols

can be purchased

- Table (implemented to display J1939 DM1 messages, but 

can be filled with any JavaScript array)

- Container (just an empty “container” to group objects 

together)



Agenda
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1. Introduction

2. Installation of the Projektor Tool

3. Updating your device

4. Getting to know the Projektor Tool

5. First project

6. CAN communication

7. Extended agenda

8. FAQ



6. CAN communication
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1. Basic settings

2. Terminal and Owner ECU configuration

3. Creating messages



6.1a CAN communication – Basic settings – CAN port

9329.01.2020

Go to the menu 

Communication -> Port Configuration…

and set the bus speed of the CAN port you 

want to use

Close the dialog



6.2a CAN communication – Terminal and Owner ECU

9429.01.2020

Go to the menu 

Communication -> Terminal and 

Owner ECU(s) Configuration…

Only three steps until we’re ready!

1. Select the CANopen protocol on CAN 1

and click Add



6.2a CAN communication – Terminal and Owner ECU

9529.01.2020

2. Choose the protocol in the drop-down-

list and configure the Node ID of the device 

as needed

Enter a name for an ECU and click Add

configure the Node ID of the ECU

Close the dialog



6.3a CAN communication – Creating messages
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Click on the CANopen shortcut in the tool 

bar or go to the menu 

Communication -> Protocols -> CANopen

-> Configure Mappings…

Create a new receive mapping by 

entering a name, choosing the type Receive

and clicking Add



6.3a CAN communication – Creating messages – Receive 
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For now the properties of the mapping

are okay, so go to the tab 

Visual CAN Mapping, search for the 

variable @ProjektCurrentPage and drag &

drop it into the mapping matrix to Byte 1, 

Bit 1

Close the dialog by clicking OK

The message has the following parameters:

COB-ID – 0x201

DLC (message length) – 4 bytes

Save and download the project to 

the device and test it



6.3a CAN communication – Creating messages – Receive 
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Use a program like PCANView and a CAN

dongle to test the CAN communication

The first message is needed to enable the 

CAN communication of the device

(as per CANopen standard):

ID – 0x000, DLC – 2, Data – 01 00 h

This enables all devices on the CAN bus

The second and third messages switch the

page.

23 in hex -> 17

44 in hex -> 2C

[23]

[44]



6.3a CAN communication – Creating messages – Transmit 

9929.01.2020

Go to the mapping dialog again

Create a Transmit mapping

The mapping automatically gets the 

COB ID 0x181

In the tab Visual CAN Mapping add the

variables push_button, switch and

@DispBacklightIntensity

Variables are organized in groups

All user-created variables go into the group “Common”

http://upload.wikimedia.org/wikipedia/commons/5/59/Info_blue.svg


6.3a CAN communication – Creating messages – Transmit 

10029.01.2020

In the properties, the Transmission Type is 

set to on value change

For cyclic sending, set the time in Event 

Timer in milliseconds

Close the dialog

Save and download the project to 

the device and test it



6.3a CAN communication – Creating messages – Transmit 

10129.01.2020

At first – no messages from the device

->Send the start message again

ID – 0x000, DLC – 2, Data – 01 00 h

Now press the buttons or change the 

backlight intensity

-> every value change triggers the message



6.3a CAN communication – Recap

10229.01.2020

We have learned how to:

- configure the basic CAN settings for CANopen

- configure the OPUS device and ECU settings

- create CAN mappings for receive and transmit PDO messages

- put variables on the CAN bus

Continue with chapter 6



6.1b CAN communication – Basic settings – CAN port
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Go to the menu 

Communication -> Port Configuration…

and set the bus speed of the CAN port you 

want to use

Close the dialog



6.2b CAN communication – Terminal and Owner ECU
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Go to the menu 

Communication -> Terminal and 

Owner ECU(s) Configuration…

Only three steps until we’re ready!

1. Select the J1939 protocol on CAN 1

and click Add



6.2b CAN communication – Terminal and Owner ECU
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2. Choose the protocol in the drop-down-

list and configure the Preferred Source

Address as needed

3. Enter a name for an ECU and click Add

configure the Source Address from the ECU

Close the dialog



6.3b CAN communication – Creating messages
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Click the J1939 shortcut in the toolbar or go 

to the menu Communication -> Protocols -> 

J1939 -> Configure Mappings…

Create a new receive mapping by 

entering a name and clicking Add



6.3b CAN communication – Creating messages
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In the Properties, change Receive From to

your ECU (e.g. J1939_ECU)

Enter 0xFABC as PGN



6.3b CAN communication – Creating messages – Receive 
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Go to the tab Visual CAN Mapping, search 

for the variable @ProjektCurrentPage and 

drag & drop it into the mapping matrix to 

Byte 1, Bit 1

Close the dialog by clicking OK

The message has the following parameters:

PGN – 0x18FABC01

DLC (message length) – 8 bytes

Save and download the project to 

the device and test it



6.3b CAN communication – Creating messages – Receive 

10929.01.2020

Use a program like PCANView and a CAN

dongle to test the CAN communication

The two messages switch the page.

23 dec in hex is 17

44 dec in hex is 2C

[23]

[44]



6.3b CAN communication – Creating messages – Transmit 
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Go to the mapping dialog again

Create a Transmit mapping

Set the PGN to 0xFABD, Transmit To to

your ECU, Send Value On to Any Variable 

Change



6.3b CAN communication – Creating messages – Transmit 

11129.01.2020

In the tab Visual CAN Mapping add the

variables push_button, switch and

@DispBacklightIntensity

Close the dialog

Save and download the project to 

the device and test it

Variables are organized in groups

All user-created variables go into the group “Common” by default

http://upload.wikimedia.org/wikipedia/commons/5/59/Info_blue.svg


6.3b CAN communication – Creating messages – Transmit 

11229.01.2020

Press the buttons or change the 

backlight intensity

-> every value change triggers the message



6.4b CAN communication – Recap
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Continue with chapter 6

We have learned how to:

- configure the basic CAN settings for J1939

- configure the OPUS device and ECU settings

- create CAN mappings for receive and transmit PGN messages

- put variables on the CAN bus



6.1c CAN communication – Basic settings – CAN port
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Go to the menu 

Communication -> Port Configuration…

and set the bus speed of the CAN port you 

want to use

Close the dialog
29.01.2020



6.2c CAN communication – Terminal and Owner ECU
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Go to the menu 

Communication -> Terminal and 

Owner ECU(s) Configuration…

Only three steps until we’re ready!

1. Select the CANFreestyle protocol on 

CAN 1 and click Add



6.2c CAN communication – Terminal and Owner ECU
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In the terminal configuration there are no 

settings necessary

Enter a name for an ECU and click Add

The ECU doesn’t need any additional

configuration

Close the dialog



6.3c CAN communication – Creating messages
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Click the CANFreestyle shortcut in the 

toolbar or go to the menu 

Communication -> Protocols -> 

CANFreestyle -> Configure Mappings…

Create a new receive mapping by 

entering a name, choosing Receive

and clicking Add



6.3c CAN communication – Creating messages – Receive 
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In the properties, enter the CAN ID 0x123



6.3c CAN communication – Creating messages – Receive 
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Go to the tab Visual CAN Mapping, search 

for the variable @ProjektCurrentPage and 

drag & drop it into the mapping matrix to 

Byte 1, Bit 1

Close the dialog by clicking OK

The message has the following parameters:

CAN-ID – 0x123

DLC (message length) – 8 bytes

Save and download the project to 

the device and test it



6.3c CAN communication – Creating messages – Receive 
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Use a program like PCANView and a CAN

dongle to test the CAN communication

The two messages switch the page.

23 dec in hex is 17

44 dec in hex is 2C
[23]

[44]



6.3c CAN communication – Creating messages – Transmit 
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Go to the mapping dialog again

Create a Transmit mapping

Set the CAN ID for the mapping to 0x124

When should the message be sent?

Set Send Value On to Any Variable Change

and/or set a Transmission Period



6.3c CAN communication – Creating messages – Transmit 
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Go to the mapping dialog again

Create a Transmit mapping

Set the CAN ID for the mapping to 0x124

In the tab Visual CAN Mapping add the

variables push_button, switch and

@DispBacklightIntensity

Close the dialog

Save and download the project to 

the device and test it



6.3c CAN communication – Creating messages – Transmit 

12329.01.2020

Press the buttons or change the 

backlight intensity

-> every value change triggers the message



6.4c CAN communication – Recap
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We have learned how to:

- configure the basic CAN settings for CAN Freestyle

- configure the OPUS device and ECU settings

- create CAN mappings for receive and transmit CAN messages

- put variables on the CAN bus



Agenda
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1. Introduction

2. Installation of the Projektor Tool

3. Updating your device

4. Getting to know the Projektor Tool

5. First project

6. CAN communication

7. Extended agenda

8. FAQ



7. Extended agenda

12629.01.2020

1. Power management

2. Visibility

3. JavaScript

4. Alarms

5. Language dependency

6. Variable Logging



7.1. Extended agenda – Power management
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OPUS devices work just like computers, 

they need to be shut down properly before 

being disconnected from power.

Disconnecting clamp 30 while the device is 

running can damage files and even the 

filesystem.

It can also result in longer startup times, 

because the filesystem has to run 

something like checkdisk, which takes time 

and slows the device down.

Always take measures so that the device 

can be shut down properly.



7.1. Extended agenda – Power management
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15

On
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15

Low

Power

PClient, JavaScripts, CAN are working

on/off                                        on/off

☐/☑ Display function ☐/☑ Multicolor LED 

☐/☑ Display backlight ☐/☑ Beeper / Speaker

☐/☑ Key backlight ☐/☑ Touchscreen

☐/☑ Key function ☑/☐ Console (RS232)

☐/☑ Encoder function ☐/☑ Video processing

☐/☑ Outputs ☐/☑ Camera output

(@PWR_LowPower_________) 
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CL

15

On

CL

15

Low

Power

PClient, JavaScripts, CAN are working

☐/☑ Display function ☐/☑ Multicolor LED 

☐/☑ Display backlight ☐/☑ Beeper / Speaker

☐/☑ Key backlight ☐/☑ Touchscreen

☐/☑ Key function ☐/☑ Console (RS232)
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☐/☑ Outputs ☐/☑ Camera output
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430 900 1000 1600
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Low Power*

(@PWR_LowPower_________) *With minimal configuration
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7. Extended agenda
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1. Power management

2. Visibility

3. JavaScript

4. Alarms

5. Language dependency

6. Variable Logging



7.2. Extended agenda – Visibility
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You can use visibility to make any object(s)

invisible / visible as you need
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You can use visibility to make any object(s)

invisible / visible as you need



7.2. Extended agenda – Visibility

15029.01.2020

There are 2 ways now to make objects 

visible / invisible

The first is described on the next slide.

The second in the next 10 slides – you decide.



7.2. Extended agenda – Visibility

15129.01.2020

Use any variable as a visibility variable

Drag & drop the variable on the object and 

choose Add as Visibility Variable

Variable == 0 -> object invisible

Variable != 0 -> object visible

Visibility_Variable != 0Visibility_Variable == 0

Continue with next chapter



7.2. Extended agenda – Visibility
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You can use visibility to make any object(s)

invisible / visible as you need

There are 64 visibility variables, 

@Visibility00 to @Visibility63

Each one of them has 16 bits.

You can use each bit of every variable to 

switch the visibility of one or several 

objects

That’s 1024 separate visibility switches



7.2. Extended agenda – Visibility – Setup

15329.01.2020

In the project properties, go to the tab 

Visibility

You can enable a visibility variable by giving

it an internal Assigned Name.

Click on Modify bit names



7.2. Extended agenda – Visibility – Setup
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Press the button Modify bit names to give 

specific names to the single bits of that 

variable. 

These names are only for you so you can 

connect the objects and the bits easily



7.2. Extended agenda – Visibility – Configuring the objects

15529.01.2020

To use visibility for any object, check the 

property Visibility and choose a visibility bit 

in the dialog for Visibility Bit

If a bit is set to 1, the object is visible, if it is 

set to 0, the object is invisible.

To set the visibility for those objects, just 

change the value of the corresponding 

@Visibilityxy variable accordingly



7.2. Extended agenda – Visibility – Using the variables

15629.01.2020

To use visibility for any object, check the 

property Visibility and choose a visibility bit 

in the dialog for Visibility Bit

If a bit is set to 1, the object is visible, if it is 

set to 0, the object is invisible.

To set the visibility for those objects, just 

change the value of the corresponding 

@Visibilityxy variable accordingly

-> Start by using only Bit0 and use different 

variables. This makes switching easy. With 

several bits used, bit operations are needed 

to switch correctly

Example: Three objects with bits 0, 1 and 2 of the visibility variable

Tractor 1 (Bit 0)

Tractor 2 (Bit 1)

Tractor 3 (Bit 2)

0

1

2

3

4

5

6

7

8

…

15

…

65535

-

✓
-

✓
-

✓
-

✓
-

✓

✓

(decimal) 1 2 3

Visibility of tractor

-

-

✓
✓
-

-

✓
✓
-

...

✓
…

✓

-

-

-

-

✓
✓
✓
✓
-

✓

✓

@Visibility value



Example: Six tractors with the following visibilities

Bit 0 Bit 1 Bit 2 Bit 3 Bit 4 Bit 5

7.2. Extended agenda – Visibility – Using the variables

15729.01.2020

Bit 0, 2 and 5 are set to 1 initially

-> Which value does the visibility variable 

have?
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Bit 0, 2 and 5 are set to 1 initially

-> Which value does the visibility variable 

have?

37 (in binary 100101)

Example: Six tractors with the following visibilities

Bit 0 Bit 1 Bit 2 Bit 3 Bit 4 Bit 5
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Bit 0, 2 and 5 are set to 1 initially

-> Which value does the visibility variable 

have?

37 (in binary 100101)

-> Which value must the variable have if I 

want to make it look like this?

Example: Six tractors with the following visibilities

Bit 0 Bit 1 Bit 2 Bit 3 Bit 4 Bit 5



7.2. Extended agenda – Visibility – Using the variables

16029.01.2020

Bit 0, 2 and 5 are set to 1 initially

-> Which value does the visibility variable 

have?

37 (in binary 100101)

-> Which value must the variable have if I 

want to make it look like this?

51 (in binary 110011)

-> What does the JavaScript code look like 

to make this change?

Example: Six tractors with the following visibilities

Bit 0 Bit 1 Bit 2 Bit 3 Bit 4 Bit 5



7.2. Extended agenda – Visibility – Using the variables
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Bit 0, 2 and 5 are set to 1 initially

-> Which value does the visibility variable 

have?

37 (in binary 100101)

-> Which value must the variable have if I 

want to make it look like this?

51 (in binary 110011)

-> What does the JavaScript code look like 

to make this change?

-> Stick with only Bit 0 in the beginning

Example: Six tractors with the following visibilities

Bit 0 Bit 1 Bit 2 Bit 3 Bit 4 Bit 5

vis = vis | 2;

vis = vis & ~ 4;

vis = vis | 16; 



7. Extended agenda
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1. Power management

2. Visibility

3. JavaScript

4. Alarms

5. Language dependency

6. Variable Logging



7.3. Extended agenda – JavaScript – Why?
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Why JavaScripts?

- value calculations (that extend the scaling operations)

- combination of several functions in one event

- change object properties

- logic programming



7.3. Extended agenda – JavaScript – Events
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Events that can trigger JavaScripts

- Project initialization

- Button / soft key actions

- Variable value changes

- cyclic execution (OnProjektRepeat / OnPageRepeat)



7.3. Extended agenda – JavaScript – Variables
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PClient JavaScriptVariables

getVariableValue

setVariableValue

Properties

getProperty

setProperty



7.3. Extended agenda – JavaScript – Infos and tips
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JavaScripts offer many possibilities, but:

• JavaScripts don‘t work in real-time (max. every 100 ms)

• Every JavaScript uses resources -> As few scripts as possible, as short as possible

• Put the right code to the right event (if you want to react on a variable value change, don’t use a cyclic script, use the 

event OnValueChangeByOwner)

• Don’t combine commands (not setVariableValue(“test”,(getVariableValue(“test”)+1);)

• Variables from the Hardware Daemon are not refreshed instantly!

-> setVariableValue(“@DispBacklightIntensity”,new_value); and then getVariableValue(“@DispBacklightIntensity”); in the 

same script will return the old value!



7.3. Extended agenda – JavaScript – More infos and tips
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• There is no “time” and no “waiting” within one JavaScript! Everything will be executed instantly

for (var x = 0; x == 100; x++)

{

setVariableValue (“test”,x);

}

will set the PClient variable “test” not to 0, then 1, then 2…, but only directly to 100.

Check out our examples to get some ideas

For a detailed syntax description:

Our HTML help for functions specific to our device, and http://www.w3schools.com/js/ for general syntax

http://www.w3schools.com/js/


7.3. Extended agenda – JavaScript – First program
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We want to create the following functionality:

Use the two buttons and create “plus 5” and “minus 5” functionality for the display backlight



7.3. Extended agenda – JavaScript – Example 1
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We want to create the following functionality:

When Digital Input 1 is active, the LED shall glow green, when it is inactive it shall not glow at all

When the Digital Input 1 is active for the first time, the project should jump from the Homepage to Page 1



7.3. Extended agenda – JavaScript – Example 1
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We want to create the following functionality:

When Digital Input 1 is active, the LED shall glow green, when it is inactive it shall not glow at all

Some tips:

- Use the event OnValueChangeByOwner of the variable @DigitalInput01

- Use the getVariableValue and setVariableValue functions to read and write the PClient variables

- The LED is controlled by the variable @LED_Multicolor

- You only need one script for this example

- Green is 0x00FF00

- If statements need to be put in brackets -> if (<statement>) 

Solution: check the project Example_JavaScript_Lesson_1



7.3. Extended agenda – JavaScript – Example 2
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We want to extend the functionality of the first example:

When Digital Input 1 is active, the LED shall glow green.

When Digital Input 2 is active, it shall glow red.

When both are active, it shall glow yellow.

When the Digital Input 1 is active for the first time, the project should jump from the Homepage to Page 1

The list object with the traffic light shall switch according to the LED color 

(DI1 -> green light, DI2 -> red light, DI1 + 2 -> yellow light).

If no input is connected, the list object shall be made invisible with the use of visibility. This should also be the 

initial state when the project starts



7.3. Extended agenda – JavaScript – Example 2
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When Digital Input 1 is active, the LED shall glow green.

When Digital Input 2 is active, it shall glow red.

When both are active, it shall glow yellow. 

When the DI1 is active for the first time, the project should jump from the Homepage to Page 1

The list object with the traffic light shall switch according to the LED color 

(DI1 -> green light, DI2 -> red light, DI1 + 2 -> yellow light).

If no input is connected, the list object shall be made invisible with the use of visibility. This should also be the 

initial state when the project starts

Hints:

- you have two events to use now, but try using still only one script

- check if you have considered all possible cases

- the initial setup at project start can be programmed with the event OnProjektInit

- remember to set up the visibility variable before using it in the project properties

- Red is 0xFF0000, Green is 0x00FF00 and Yellow is 0xFFFF00

Solution: check the project Example_JavaScript_Lesson_2



7. Extended agenda

17329.01.2020

1. Power management

2. Visibility

3. JavaScript

4. Alarms

5. Language dependency

6. Variable Logging



7.4. Extended agenda – Alarms – Alarm templates

17429.01.2020

Alarms are pages or smaller popup frames 

that can be opened and closed by setting a 

single variable.

First the alarm templates can be configured

in the project properties

Type Page means a full screen alarm, with 

Frame you can set size and position of the 

alarm popup in the X, Y, Width and Height 

column



7.4. Extended agenda – Alarms – Alarm templates
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The Behaviour determines how the alarm 

can be closed:

Emergency: 

- by setting the alarm variable

Warning: 

- by setting the alarm variable

- by pressing the Escape key

Informational:

- by setting the alarm variable

- by pressing the Escape key

- automatically after a timeout



7.4. Extended agenda – Alarms – A new alarm
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To create an alarm, right click on Alarms (x)

and select New Alarm Type and then the 

alarm template of your choice

In the dialog enter a unique alarm number. 

This will be used to open/close the alarm.

The actual alarm page can be configured

just as a normal project page with all the 

objects.

The blue area is the alarm area, the white 

area will be transparent, i.e. you see the 

page below it



7.4. Extended agenda – Alarms – Alarm variable

17729.01.2020

To show the alarm with the number 12,

set the variable 

@AlarmShow to 0x800C (or 32780 decimal)

To remove the alarm with the number 12,

set the variable 

@AlarmShow to 0x000C (or 12 decimal)

-> To set an alarm, set the variable to 

0x8000 || alarm number (in hexadecimal)

-> To remove an alarm, set the variable to 

just the alarm number (in hexadecimal)



7.4. Extended agenda – Alarms – Setting the alarm

17829.01.2020

Alarms can be set

- over CAN (put the variable @AlarmShow

into a mapping)

- over JavaScript (by setting the variable)

- with a button / soft key action (Set Value)

- with any other event



7.4. Extended agenda – Alarms – Alarm priorities

17929.01.2020

Alarm types also have a priority

This determines which alarm is shown on 

top when more than 1 are activeLow
Med

Emerg.



Warn 3
Warn 2

7.4. Extended agenda – Alarms – Alarm priorities

18029.01.2020

For alarms with the same priority the 

behavior can be set to LIFO (last in – first 

out) or FIFO (first in – first out)

Warn 1 Warn 2 Warn 3

FIFO

Warn 1

Warn 1
Warn 2

Warn 3

LIFO



7. Extended agenda

18129.01.2020

1. Power management

2. Visibility

3. JavaScript

4. Alarms

5. Language dependency

6. Variable Logging



7.5. Extended agenda – Language dependency – Setup

18229.01.2020

You can add new languages in the project 

properties in the tab Languages

Create a new language by writing a two 

letter code and a language name, then click 

add.

The most important element for changing 

the language in the project is the index



7.5. Extended agenda – Language dependency – Objects

18329.01.2020

To prepare objects for language 

dependency, set their property Dependency

to Language

For the string fields, the text (Preview 

Value) can be changed manually for all the 

languages. You can also change the 

alignment and the font file for each 

language



7.5. Extended agenda – Language dependency – Import / export
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You can export a table for each source –

target language pair into a csv file to 

translate everything at once

Go to Tools -> Import Export Language CSV

Select a source and a target language and 

the file will be created.

Once the translation is done, import the 

file back into the Projektor Tool.

You can preview the changes, then click on 

Import to import the texts.



7.5. Extended agenda – Language dependency – Changing the language
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For a preview you can change the language 

in the toolbar in the Projektor Tool

To change the language on the device, set 

the variable @SettingsLanguageEnum to 

the index number of the desired language

The current language can be set

- over CAN (put the variable 

@SettingsLanguageEnum into a mapping)

- over JavaScript (by setting the variable)

- with a button / soft key action (Set Value)

- with any other event



7. Extended agenda

18629.01.2020

1. Power management

2. Visibility

3. JavaScript

4. Alarms

5. Language dependency

6. Variable Logging



7.6. Extended agenda – Variable logging

18729.01.2020

You can log the values of any variable on 

the file system of the device

Setup variable logging in the project 

properties in the tab Variable Logging

In the first tab you can select any variable 

that you want to log

To add a variable for logging, select it in the 

list on the left and click Add>>



7.6. Extended agenda – Variable logging

18829.01.2020

In the general options, select Event Based 

Logging

In the file settings you can switch between 

only one backup file (Continuous Logging) 

or 4 to 50 backup files.

In both cases you have a ringbuffer

functionality



7.6. Extended agenda – Variable logging
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In the last tab you can select, which 

variable should be logged when.

The best event to choose is 

OnValueChange

You can use the log level to set different 

verbose levels

Set the variable @LogLevel in the project

to decide which variables should be logged.

To copy/move the log files on a USB stick, 

set the variable @LogCopyAllNow to ½

(also see example project)

Example: Three variables with set up log level 1,5 and 9

Project log level
Variables will be logged

1      5     9

1

2,3

4

5

6,7

8

9

✓
✓
✓
✓
✓
✓
✓

-

-

-

✓
✓
✓
✓

-

-

-

-

-

-

✓



7. Extended agenda – Recap

19029.01.2020

We have learned how to:

- use power management to save battery power

- use visibility to manage object visibility

- use JavaScripts and when

- much more



Agenda

19129.01.2020

1. Introduction

2. Installation of the Projektor Tool

3. Updating your device

4. Getting to know the Projektor Tool

5. First project

6. CAN communication

7. Extended agenda

8. FAQ

Thank you for your attention –

last call for questions!*

*but we’re still there if you think of them 

later (which you will)



8. FAQ

19229.01.2020

1. Can I integrate the project into the PClient update?

2. Which variables can I change how?

3. How can I use the beeper?

4. How can I change the boot logo?

5. What can I do with the serial console

6. Why are the loading times of my project increasing over time?

7. How can I use the virtual keyboard?



8.1 FAQ – Can I integrate the project into the PClient update?

19329.01.2020

Yes. 

Save your project, then go to your project folder, there is a folder called \terminal_files.

Now open the application update file user.tar.gz with a program like 7zip. In it, browse to the folder

user.tar.gz\user.tar\pclient\projekte\default_prj\

Delete the folder \terminal_files in the user.tar.gz file and drag & drop your project folder into the file at the 

above location.

Remember that you need to re-create the checksum file for the user.tar.gz



8.2 FAQ – Which variables can I change how?

19429.01.2020

Any variable in the project that isn’t configured as read-only, both pre-defined and user created, can be changed

- by using the action Set Value

- through user input, by connecting the variable to an editable object

- over CAN

- within a JavaScript file



8.3 FAQ – How can I use the beeper?

19529.01.2020

The beeper can be used with alarms and on touch / keypress events or with variables.

Please check the example project for beeper to see examples.



8.4 FAQ – How can I change the boot logo?

19629.01.2020

Please read the 

OPUS devices update manual for 

step-by-step instructions



8.5 FAQ – What can I do with the serial console?

19729.01.2020

Preinstalled BusyBox with lots of standard

Linux commands

df – list mounted devices (check if USB stick is mounted)

top – executes a process manager (check if Pclient is running)

dmesg – lists all diagnostic messages from the system

ls -la – list files and folders in the current folder

cd – change directory 

cp – copy a file (-rf to also copy folders)

mv – move a file (-rf to also move folders)

ifconfig – check Ethernet port configuration

reboot – performs a restart of the device

/opt/etc/init.d/02_pclient start / stop / restart – starts, stops or 

restarts the pclient

Please also check the document Console_Commands.pdf



19829.01.2020

The file system (JFFS2) runs something like checkdisk sometimes to ensure all files are in good condition.

With an increasing amount of file operations (like installing a lot of new project versions) this will happen more 

often, and especially at startup. This can slow down the loading process significantly.

The solution would be a clean reinstallation of the PCLient, as then the /opt partition will be deleted and created 

freshly.

8.6 FAQ – Why are the loading times of my project increasing over time?



19929.01.2020

Right-click on Virtual Keyboards in the 

project tree, choose Layered for text, 

Numeric for numbers

In the object properties, activate Set As 

Input, then choose Virtual Keyboard as 

Inplace Editor

Now when the object is edited, the virtual 

keyboard will pop up

8.7 FAQ – How can I use the virtual keyboard?



20029.01.2020

That’s it!

If you’re still reading, you are cordially invited to read on in the OPUS Projektor manual.

It contains a tutorial, an F.A.Q. and information about almost everything.

You can access the help by pressing F1 or going to the menu Help -> Help


